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Introduction to WinConnect Server VS
Product Description
WinConnect Server VS is a software solution that enables a Windows Vista Business, Windows Vista
Ultimate, Windows 7 Professional, Windows 7 Ultimate, Windows Server 2008 (32-bit & 64-bit),
Windows Server 2008 R2, Windows Server 2008 R2 Foundation, Windows Small Business Server 2008
or Windows Small Business Server 2011 (64-bit) Host computer to allow multiple Remote Desktop
Protocol (RDP) 4.0, 5.0, 5.1, 5.2, 6.x and 7.x-enabled devices (such as Terminals, Internet/Information
Appliances, Tablet PCs and PDAs) to connect to it to run Windows applications simultaneously and
independently. You can remotely connect to your computer from another office, from home, or while
traveling. This allows you to use the data, applications, and network resources that are on your office
computer, without physically being in your office.
A broadband Internet connection over digital subscriber line (DSL, ADSL) or Integrated Services
Digital Network (ISDN) connection improves performance, but it is not necessary because Remote
Desktop transfers only the minimal data (such as display data and keyboard data) to remotely control
your Host computer. Therefore, even low–bandwidth Internet connections or a wired or wireless
TCP/IP connection, local area network (LAN), wide area network (WAN), dial-up (Internet), virtual
private network (VPN) connection allow you to remotely connect to your office computer.
Users on the Thin Client devices may run the same or different applications simultaneously and
independently to create and edit documents, and to share peripherals, for example, CD-ROM, printers
and other hardware installed on the Host computer. All users can also surf the Internet and access
emails at the same time and even share network access with unique customized desktop and login.

Hardware Requirements
WinConnect Server VS requires a Windows Vista Business, Windows Vista Ultimate, Windows 7
Professional, Windows 7 Ultimate, Windows Server 2008 (32-bit & 64-bit), Windows Server 2008 R2,
Windows Server 2008 R2 Foundation, Windows Small Business Server 2008 or Windows Small
Business Server 2011 (64-bit) computer with Network/Internet connection.
For Windows Vista Business, Windows Vista Ultimate, Windows 7 Professional or Windows 7
Ultimate (32-bit & 64-bit), the minimum memory requirement for 3 Remote Desktop users is (3 x 256
Megabytes) + 1 Gigabytes of RAM.
For Windows Small Business Server 2008 or Windows Small Business Server 2011 (64-bit), the
minimum memory requirement for 3 Remote Desktop users is (3 x 256 Megabytes) + 4 Gigabytes of
RAM.
For Windows Server 2008 (32-bit & 64-bit), Windows Server 2008 R2 or Windows Server 2008 R2
Foundation (64-bit), the minimum memory requirement for 3 Remote Desktop users is (3 x 256
Megabytes) + 2 Gigabytes of RAM
An additional memory of 256MB or more is required for each additional Remote Desktop user,
depending on the applications the user will be running.

Manufacturer’s Notice
The WinConnect Server VS allows multiple users to simultaneously and independently share the same
hardware and software installed on the Host computer. Some software is licensed for use on a single
computer while other software may be licensed for single or multiple users. It is the responsibility of the
WinConnect Server VS purchaser/user to read and comply with the licensing agreements of any
software that may be used on the RDP devices.
A separate Windows Vista/Windows 7 license may be required for each RDP device connected to the
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Host computer running Windows Vista/Windows 7. It is the responsibility of the WinConnect Server
VS purchaser/user to read and comply with the Windows Vista/Windows 7 licensing agreement or
contact Microsoft for clarification regarding this licensing requirement.

Terminology
The Host is the computer where Windows Vista Business, Windows Vista Ultimate, Windows 7
Professional, Windows 7 Ultimate, Windows Server 2008 (32-bit & 64-bit), Windows Server 2008 R2
Windows Server 2008 R2 Foundation, Windows Small Business Server 2008 or Windows Small
Business Server 2011 (64-bit) and WinConnect Server VS software are installed.
The Client is the Remote Desktop Protocol (RDP) 4.0, 5.0, 5.1, 5.2, 6.x or 7.x-enabled device (such as
Terminal, Internet/Information Appliance, Tablet PC and PDA).

Hardware Guidelines
CPU
A Pentium IV processor at 2.8GHz or faster is suggested for 1 Host and 3 Remote Desktop users. Equivalent
AMD processors are also supported. Increase the processor speed by 100MHz or more per additional Remote
Desktop user.
Recommended




Pentium IV 2.8 GHz (1 Host and 3
Remote Desktop users) or faster
processor
Increase processor speed by
100MHz or more per additional
Remote Desktop user, depending
on the applications the user will be
running

Memory
For Windows Vista Business, Windows Vista Ultimate, Windows 7 Professional or Windows 7 Ultimate (32-bit
& 64-bit), the minimum memory requirement for 3 Remote Desktop users is (3 x 256 Megabytes) + 1
Gigabytes of RAM.
For Windows Small Business Server 2008 or Windows Small Business Server 2011 (64-bit), the minimum
memory requirement for 3 Remote Desktop users is (3 x 256 Megabytes) + 4 Gigabytes of RAM.
For Windows Server 2008 (32-bit & 64-bit), Windows Server 2008 R2 or Windows Server 2008 R2
Foundation (64-bit), the minimum memory requirement for 3 Remote Desktop users is (3 x 256 Megabytes) +
2 Gigabytes of RAM.
256 MB of additional RAM or more is recommended for each additional Remote Desktop user, depending on
the applications the user will be running.
Minimum




(3 x 256 MB) + 1GB for Windows Vista
Business, Windows Vista Ultimate,
Windows 7 Professional or Windows 7
Ultimate (3 Remote Desktop users)
(3 x 256 MB) + 4GB for Windows Small
Business Server 2008/ 2011 (3 Remote
Desktop users)
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(3 x 256 MB) + 2 GB for Windows
Server 2008 or Windows Server 2008
R2/R2 Foundation (3 Remote Desktop
users)

Recommended


Add an additional 256 MB or more per
additional Remote Desktop user
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1.

WinConnect Server VS Installation

1.1. Installing the WinConnect Server VS Software for Windows Vista, Windows
7, Windows Server 2008 (32-bit) System
Windows Server 2008 native terminal services or Windows Vista/Windows 7 native Remote Desktop must be
working correctly before the WinConnect Server VS software is installed. To verify if it works, you can use a
remote client to connect to the Windows Server 2008 native terminal services or Windows Vista/Windows 7
native Remote Desktop.
Make sure that you have also configured your Windows Firewall (or any Firewall) not to block TCP ports 3389
(0d3d Hex) and 36157 (8d3d Hex).
Installation is simple. By following these steps, a WinConnect Server VS system should take less than 10
minutes to set up. Each step is explained in detail in the following pages.

Step 1.
Download the WinConnect Server VS software from www.thinsoftinc.com. Once this file is
saved onto your hard disk, locate it and double-click on the filename, setup.exe.

Step 2.
Follow the instructions on the screen. Click “Next” to proceed.

Step 3.
After reading and accepting the license agreement, click on the “Next” button to continue with the
WinConnect Server VS software installation.
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Step 4.
You should see a window similar to the one below. Click on the “Next” button.

Step 5.
To install the WinConnect Server VS software to the default folder, click “Next” to proceed.

Step 6.
Select the additional tasks you would like to perform while installing WinConnect Server VS. Click
“Next” to proceed.
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Step 7.
Review the settings in the InstallShield Wizard. Click “Next” to proceed or “Back” to modify the
settings.

Step 8.
Once the InstallShield Wizard has successfully installed the WinConnect Server VS software, you will
be prompted to restart your computer. Click “Finish” to complete the setup.
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Congratulations! You have fully installed the WinConnect Server VS software. You are now ready to install the
Remote Desktop Client for Linux or Windows System.
Important Note:
1. For Windows Server 2008 (32-bit) Host - Only users who are members of the “Remote Desktop Users”
group can login into the Windows Server 2008 computer using Remote Desktop connection.
To edit the Remote Desktop Users group, right click on My Computer, select Remote and click on
"Select Remote Users…" to add or remove Remote Desktop users.
2. For Windows Vista/Windows 7 (32-bit) Host - Remote Desktop feature need to be enabled so that Remote
Desktop users can login into the computer using Remote Desktop connection.
To enable the Remote Desktop feature, select Windows Start => Settings => Control Panel => Windows
Firewall. Click on Turn Windows Firewall on or off on the side navigation bar. Under the “Exceptions” tab, check
the box “Remote Desktop” under Program or Port.

1.2. Installing the WinConnect Server VS Software for Windows Vista, Windows
7, Windows Small Business Server 2008/2011, Windows Server 2008, Windows
Server 2008 R2, Windows Server 2008 R2 Foundation (64-bit) System
Windows Small Business Server 2008/Windows Small Business Server 2011/Windows Server 2008/Windows
Server 2008 R2/Windows Server 2008 R2 Foundation native terminal services or Windows Vista/Windows 7
native Remote Desktop must be working correctly before the WinConnect Server VS software is installed. To
verify if it works, you can use a remote client to connect to the Windows Small Business Server 2008/Windows
Small Business Server 2011/Windows Server 2008/Windows Server 2008 R2/Windows Server 2008 R2
Foundation native terminal services or Windows Vista/Windows 7 native Remote Desktop.
Make sure that you have also configured your Windows Firewall (or any Firewall) not to block TCP ports 3389
(0d3d Hex).
Installation is simple. By following these steps, a WinConnect Server VS system should take less than 10
minutes to set up. Each step is explained in detail in the following pages.

Step 1.
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Download the WinConnect Server VS software from www.thinsoftinc.com. Once this file is
saved onto your hard disk, locate it and double-click on the filename, setup.exe.

Step 2.
Follow the instructions on the screen. Click “Next” to proceed.

Step 3.
After reading and accepting the license agreement, click on the “Next” button to continue with the
WinConnect Server VS software installation.

Step 4.
You should see a window similar to the one below. Click on the “Next” button.
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Step 5.
To install the WinConnect Server VS software to the default folder, click “Next” to proceed.

Step 6.
Select the additional tasks you would like to perform while installing WinConnect Server VS. Click
“Next” to proceed.
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Step 7.
Review the settings in the InstallShield Wizard. Click “Next” to proceed or “Back” to modify the
settings.

Step 8.
Once the InstallShield Wizard has successfully installed the WinConnect Server VS software, you will
be prompted to restart your computer. Click “Finish” to complete the setup.

Congratulations! You have fully installed the WinConnect Server VS software. You are now ready to install the
Remote Desktop Client for Linux or Windows System.
Important Note:
1. For Windows Small Business Server 2008/2011, Windows Server 2008 and Windows Server 2008 R2/R2
Foundation (64-bit) Host - Only users who are members of the “Remote Desktop Users” group can login into
the Windows Small Business Server 2008/2011, Windows Server 2008 or Windows Server 2008 R2/R2
Foundation (64-bit) computer using Remote Desktop connection.
To edit the Remote Desktop Users group, right click on My Computer, select Remote and click on
"Select Remote Users…" to add or remove Remote Desktop users.
2. For Windows Vista/Windows 7 (64-bit) Host - Remote Desktop feature need to be enabled so that Remote
Desktop users can login into the computer using Remote Desktop connection.
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To enable the Remote Desktop feature, select Windows Start => Settings => Control Panel => Windows
Firewall. Click on Turn Windows Firewall on or off on the side navigation bar. Under the “Exceptions” tab, check
the box “Remote Desktop” under Program or Port.

1.3.

Using the WinConnect Server VS Control Center

The WinConnect Server VS Control Center can be used to view the Remote Desktop connections, as well as
the processes and applications that are running on each Remote Desktop session. It allows you to send
messages to the Remote Desktop users, logoff or disconnect the Remote Desktop sessions on the
WinConnect Server VS Host.
To view the Remote Desktop Client connections, click on the “+” sign next to the WinConnect Server VS
Host computer name.
Note: User must start the WinConnect Server VS Control Center using "Run as administrator" to
change settings in the WinConnect Server VS Control Center. To enable the Administrator
privilege, right-click on the WinConnect Server VS Control Center and select “Run as
administrator”.

There are nine icons in the toolbar of the Control Center – Refresh, Connect Session, Disconnect Session, Logoff
Session, Send Message, Remote Control, Properties, About and Online Help.

1.3.1.

Refresh

Refresh is selected by clicking on the “Refresh” icon.
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The Remote Desktop connections displayed are periodically refreshed to update any connection status changes.
If you do not wish to wait for the periodic refresh to update any connection status changes, you can click on
the “Refresh” button for an immediate update.
1.3.2.

Connect Session

Connect session is selected by clicking on the “Connect session” icon.

To connect to a Disconnected Remote Desktop session on the WinConnect Server VS Host, you can rightclick on the Disconnected Remote Desktop session “RDP-Tcp#1(XXX)” where XXX is the user login name
and select “Connect”.
1.3.3.

Disconnect Session

Disconnect session is selected by clicking on the “Disconnect session” icon.

To disconnect an active Remote Desktop session on the WinConnect Server VS Host. you can right-click on
the active Remote Desktop session “RDP-Tcp#1(XXX)” where XXX is the user login name and select
“Disconnect”.
Disconnect leaves the Remote Desktop session, including any applications running within the Remote Desktop
session, active on the Terminal Server even though the Remote Desktop Client is not actually controlling it. As
a result, the Remote Desktop session still consumes resources on the Terminal Server. When the same user
login into the Terminal Server at a later time, the user reconnects to the disconnected Remote Desktop session.
This feature is useful if the user wishes to run a time consuming operation, such as a report generation or
database query, disconnects from the Remote Desktop session and login into the Terminal Server at a later
time, reconnects to the disconnected Remote Desktop session, to view the results or resume the task.
Note: Only a user with administrative rights can disconnect an active Remote Desktop session.
1.3.4.

Logoff Session

Logoff session is selected by clicking on the “Logoff session ” icon.

To logoff a Remote Desktop session on the WinConnect Server VS Host. Alternatively, you can right-click on
the Remote Desktop session “RDP-Tcp#1(XXX)” where XXX is the user login name and select “Logoff”.
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Logoff ends the Remote Desktop session running on the Terminal Server; terminating any applications running
within the Remote Desktop session and all changes not saved will be lost. When the user login into the
Terminal Server the next time, a new Remote Desktop session is created. In general, it is preferable to logoff a
Remote Desktop session rather than disconnect a Remote Desktop session.
Note: Only a user with administrative rights can logoff a Remote Desktop session.
1.3.5.

Send Message

Send message is selected by clicking on the “Send message ” icon.

To send a message to a Remote Desktop user. Alternatively, you can right-click on the Remote Desktop
session “RDP-Tcp#1(XXX)” where XXX is the user login name and select “Send message”.

1.3.6.

Remote Control

Remote Control is selected by clicking on the “Remote Control” icon.

To enable a Remote Desktop session to remote control or shadow another Remote Desktop session.
Note: The Console session cannot remote control or shadow a Remote Desktop session, and vice versa.
Note: Only a user with administrative rights can remote control or shadow another Remote Desktop session.
To view or change the Remote Control settings, right-click on the WinConnect Server VS Host computer
name (e.g. SE7500) and select “Properties”. Double-click on the Remote Control options to change the
setting. Please refer to Remote Control Settings section below for details.
1.3.7.

Properties

Properties is selected by clicking on the “Properties” icon.
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To view or change the Server and RDP settings. Alternatively, you can right-click on the WinConnect Server
VS Host computer name (e.g. I965) and select “Properties”. Double-click on the respective feature to change
the setting.

Server Settings:


Remote Desktop - enables or disables the ability for Remote Desktop Clients to connect to the
WinConnect Server VS Host using Remote Desktop connection. Default is “Enabled”.



Remote Assistance - enables or disables the ability to send invitation for Remote Assistance. Default
is “Enabled”.



WinConnect Server RDP - enables or disables WinConnect Server VS Host Remote Desktop
support. Changing this setting requires a system reboot. Default is “Enabled”.



Advertise Terminal Services - determines if the Terminal Server advertises itself as a Terminal
Server on the local network. When enabled, it allows Remote Desktop Clients to locate the available
Terminal Servers on the local network. Default is “Yes”.



Restrict Computer Shutdown Privileges – allows any user to shutdown the system or restrict the
shutdown option to users with Administrator privileges. Restricting shutdown to Administrator
requires an Administrator to login to shutdown the system. Domain security policies may override
this setting. Default is “Any user”.



Hide WCS System Tray Icon – shows or hides the Remote Desktop session icon. The icon
provides access to Windows Task Manager and Disconnect option. Default is “No”.

RemoteApp:


Restrict RemoteApp Program Use – restricts RDP clients "Initial Programs" to those specified in
the list. If set to "No", WinConnect Server will allow the remote clients to run any initial program
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upon remote connection. If set to "Yes", WinConnect Server will only allow the remote clients to run
the initial program as specified in the list upon remote connection. Default setting is "No".
RDP Settings:


Max Displayable Colors - limits the maximum number of colors supported under the Remote
Desktop session. More colors mean more network bandwidth is required for data transfer. Fewer
colors reduce the network bandwidth required and improve the overall performance. Default is “32bit colors”.
Note: 24-bit color is currently not supported in Windows Vista, Windows 7, Windows Server 2008
(32-bit & 64-bit), Windows Server 2008 R2/R2 Foundation and Windows Small Business Server
2008/2011 (64-bit). Should you have any query, please contact Microsoft for more information.



Max Session Connection Time - specifies the Terminal Server's maximum time limit a Remote
Desktop session can stay connected before the Terminal Server automatically disconnects or
terminates the Remote Desktop session. Default is “Never”.
Note:



Max Session Disconnection Time - specifies the Terminal Server's maximum time limit a Remote
Desktop session can stay disconnected before the Terminal Server automatically logs off or
terminates the disconnected Remote Desktop session. Default is “Never”.
Note:



The “Override user settings?” option needs to be checked in order for the Terminal Server's
setting to take effect.

Max Session Idle Time - specifies the Terminal Server's maximum time limit a Remote Desktop
session can remain idle (i.e. no keyboard or mouse activity) before the Terminal Server automatically
disconnects the Remote Desktop session. Default is “Never”.
Note:



The “Override user settings?” option needs to be checked in order for the Terminal Server's
setting to take effect.

The “Override user settings?” option needs to be checked in order for the Terminal Server's
setting to take effect.

On Timeout or Disconnect – specify the action the Terminal Server needs to do when a Remote
Desktop session reaches its session limit or timeout, or if a Remote Desktop session becomes
accidentally disconnected (broken connection). The Terminal Server can disconnect or terminate the
Remote Desktop session. Default is “Disconnect Session”.
Note:

The “Override user settings?” option needs to be checked in order for the Terminal Server's
setting to take effect.



Min Encryption Level - specifies the minimum encryption level required for a Remote Desktop
Client to connect to the Terminal Server: High, Medium or Low. Default is “Medium”.



Always Prompt for Password – asks for a logon password when the Remote Desktop Client
connects to the Terminal Server and ignore any logon password sent by the Remote Desktop Client.
Default is “No”.



Limit Blank Password Use – limits local account use of blank passwords to console logon only. If
set to “Yes”, Remote Desktop User (apply to local user account only, i.e. Non-Domain user account)
will need to a password to logon into Windows. Default is “Yes”.
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Single Session Per User – restrict a user to a single Remote Desktop session. When enabled, the
active Remote Desktop session will be disconnected when the same user login on another Remote
Desktop session. When disabled, the same user can login on multiple Remote Desktop sessions.
Default is “Yes.



Only login RemoteDesktopUsers Group – specifies the group of users that can login into the
Terminal Server using Remote Desktop connection. When enabled, only users who are members of
the “Remote Desktop Users” group can login into the Terminal Server using Remote Desktop
connection. When disabled, any users can login into the Terminal Server using Remote Desktop
connection. Default is “No”.
To edit the Remote Desktop Users group, right click on My Computer, select Remote and click on
"Select Remote Users…" to add or remove Remote Desktop users.

Reconnect Settings:


Use Reconnection Settings from User – specifies if the Reconnect setting is set to use the each
individual user’s setting or the Terminal Server’s Reconnect setting. Default is “Yes” (i.e. use the
individual user's setting).
To change a user's Reconnect setting, please refer to User Settings section below for details.



Allow Reconnection – specifies the Terminal Server's Reconnect setting to allow a user to reconnect
to a disconnected Remote Desktop session from any computer or only allow a user to reconnect to a
disconnected Remote Desktop session from same the computer that originally started the Remote
Desktop session. The default Terminal Server's Reconnect setting is to allow reconnection “From any
client”, this is a global setting for all users.

Remote Control Settings:


Use Remote Control Settings from User – specifies if the Remote Control setting is set to use each
individual user’s setting or the Terminal Server’s Remote Control setting. Default is “Yes”.
To change a user's Remote Control setting, please refer to User Settings section below for details



Remote Control Settings – specifies the Terminal Server's Remote Control setting to enabled or
disabled, whether input from the controlling session is allowed (i.e. remote control versus just
monitoring) and whether the remote user should be notified first. The default Terminal Server’s
Remote Control setting is “Enabled (allow input, notify user)”, this is a global setting for all users.

Client Features:


Enable Audio Mapping – enables or disables the Terminal Server to allow the Remote Desktop
session's audio to be re-directed to the Remote Desktop Client. When enabled, this allows audio
generated by an application running within the Remote Desktop session to be playback on the
Remote Desktop Client. Default is “Enabled”.



Enable Drive Mapping – enables or disables the Terminal Server to allow the Remote Desktop
Client’s local drives to be mapped to the Remote Desktop session. When enabled, this allows an
application running within the Remote Desktop session to access the local drives on the Remote
Desktop Client. Default is “Enabled”.
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Enable COM Port Mapping – enables or disables the Terminal Server to allow the Remote
Desktop Client’s local COM ports to be re-directed to the Remote Desktop session. When enabled,
this allows an application running within the Remote Desktop session to access the COM ports on
the Remote Desktop Client. Default is “Enabled”.



Enable LPT Port Mapping – enables or disables the Terminal Server to allow the Remote Desktop
Client’s local LPT ports to be re-directed to the Remote Desktop session. When enabled, this allows
an application running within the Remote Desktop session to access the LPT ports on the Remote
Desktop Client. Default is “Enabled”.



Enable Windows Printer Mapping – enables or disables the Terminal Server to allow the Remote
Desktop Client’s local printers to be re-directed to the Remote Desktop session. When enabled, this
allows an application running within the Remote Desktop session to print to the local printer
connected to the LPT port of the Remote Desktop Client. Default is “Enabled”.



Enable Clipboard – enable or disable the Terminal Server to allow the Remote Desktop Client’s
Clipboard to be shared from within the Remote Desktop session. When enabled, this allows copying
and pasting of data between applications running within the Remote Desktop session and applications
running on the Remote Desktop Client. Default is “Enabled”.

Note:

The Remote Desktop Client's Remote Desktop Connection software's (i.e. the software used by
the Remote Desktop Client to connect to the Terminal Server) equivalent features must be
enabled as well, in order for any of the above features to work correctly (i.e. the feature must be
enabled on both the Terminal Server and Remote Desktop Client).

To look at the processes and applications that are running on the Remote Desktop Clients, left-click on the
client connection “RDP-Tcp#1(XXX)” where XXX is the user login name.

1.3.8.

About

About is selected by clicking on the “About” icon.
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The About page displays information about the WinConnect Server VS.

1.3.9.

Online Help

Online help is selected by clicking on the “Online help” icon.

Clicking on this button, it will invoke your web browser and link you to the ThinSoft Technical Support’s web
site.
1.3.10.

Menu Options

Additional options are available from the menu bar at the top of the WinConnect Server VS Control Center.

1.3.10.1 File Menu
The File menu allows users to close the Control Center application.

To exit, select File/Exit on the Control Center’s main menu bar.
1.3.10.2 View Menu
The View menu allows users to view the Remote Desktop Client connections, as well as the processes and
applications that are running on the Remote Desktop Clients.

 Toolbar – displays the seven icons in the toolbar of the Control Center – Refresh, Disconnect
Session, Logoff Session, Send Message, Properties, About and Online Help.
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 Status Bar – displays the event status at the bottom of the Control Center.
 Refresh - displays the changes in the Remote Desktop Client connection status.

1.3.10.3 Actions Menu
The Actions menu allows users to view or change the Server and RDP settings, remote control or shadow to
or from a Remote Desktop session and send messages to the Remote Desktop users on the Remote Desktop
Clients. Users can logoff or disconnect the Remote Desktop Clients and connect a disconnected Remote
Desktop session on the WinConnect Server VS Host.



Connect – connects a disconnected Remote Desktop session on the WinConnect Server VS Host.
To connect, click on the “Connect session” icon in the toolbar of the Control Center; or select
Actions/Connect on the Control Center’s main menu bar.



Disconnect – disconnects an active Remote Desktop session on the WinConnect Server VS Host.
To disconnect, click on the “Disconnect session” icon in the toolbar of the Control Center; or select
Actions/Disconnect on the Control Center’s main menu bar.
Note: Only a user with administrative rights can disconnect an active Remote Desktop session.

 Logoff – logoff a Remote Desktop session on the WinConnect Server VS Host. To logoff, click on
the “Logoff session” icon in the toolbar of the Control Center; or select Actions/Logoff on the
Control Center’s main menu bar.
Note: Only a user with administrative rights can log off a Remote Desktop session.

 Send Message - sends a message to the users on the Remote Desktop Clients by clicking on the
“Send Message” icon in the toolbar of the Control Center; or select Actions/Send Message on the
Control Center’s main menu bar.


Remote Control – remote control or shadow to or from an Remote Desktop session by clicking on
the “Remote Control” icon in the toolbar of the Control Center; or select Actions/Remote Control
on the Control Center’s main menu bar. You can’t remote control to or from a Console session.
Note: The Console session cannot remote control or shadow a Remote Desktop session, and vice
versa.
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Note: Only a user with administrative rights can remote control or shadow another Remote Desktop
session.


User Settings – to change a user’s settings, please refer to User Settings section below for details.

 Properties - views or changes the Server and RDP settings in the Control Center by clicking on the
“Properties” icon in the toolbar of the Control Center; or select Actions/Properties on the Control
Center’s main menu bar.

1.3.10.4 Options Menu

The Options menu allows users to select different languages for the WinConnect Server VS Control Center if
desired and to edit the user settings.



Set Language – sets different languages for the WinConnect Server VS Control Center.



User Settings – to view or change a user's settings.


To change a local user's settings (i.e. a local user on the local machine where WinConnect Server
VS is installed), you will need to first login as a Local Administrator.



To change a domain user's settings, (i.e. a domain user on a Domain Controller), you will need to
first login as a Domain Controller Administrator.
Note: To change a domain user's settings, it is strongly recommended that the changes be made
on the Domain Controller itself. Please refer to the Domain Controller Administrator for any
changes.



To change a user's settings, enter the Username, the Server name where the Username was
created and click "OK". The Server name, Username and the user's current settings will be
displayed.
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Allow RDP Logon – to enable or disable the user to be allowed to login into the Terminal
Server using Remote Desktop connection. Default is "Yes", i.e. user is allowed to login into the
Terminal Server using Remote Desktop connection.



Use Initial Program from Client – determines if the user's settings (i.e. Initial Program and
Working Directory settings) or the Remote Desktop Client's Remote Desktop connection
software’s settings will be used to specify the initial program to be run at logon. Default is “Yes”,
i.e. Remote Desktop Client's Remote Desktop connection software’s settings will be used to
specify the initial program to be run at logon.



Initial Program – specifies the path of the initial program to be run at logon if the Use Initial
Program from Client setting is set to "No". When the program is terminated, the user will be
logged off from the Terminal Server. Default is “None”. To indicate the path of the working
directory used by the initial program, please refer to the “Working Directory” setting.



Working Directory – specifies the path of the working directory used by the initial program if
the Use Initial Program from Client option is set to "No". Default is “None”.



Max Session Connection Time - specifies the maximum time limit a Remote Desktop session
can stay connected before the server automatically disconnects the Remote Desktop session.
Default is “Never”.



Max Session Disconnection Time - specifies the maximum time limit a Remote Desktop
session can stay disconnected before the Terminal Server automatically logs off or terminates the
disconnected Remote Desktop session. Default is “Never”.



Max Session Idle Time - specifies the maximum time limit a Remote Desktop session can
remain idle (i.e. no keyboard or mouse activity) before the Terminal Server automatically
disconnects the Remote Desktop session. Default is “Never”.



On Timeout or Disconnect – instructs the Terminal Server what to do when a Remote
Desktop session reaches its session limit or timeout, or if a Remote Desktop session becomes
accidentally disconnected (broken connection). The Terminal Server can disconnect or terminate
the Remote Desktop session. Default is “Disconnect Session”.



Allow Reconnection – specifies the Reconnect setting to allow the user to reconnect to a
disconnected Remote Desktop session from any computer or only allow the user to reconnect to
a disconnected Remote Desktop session from same the computer that originally started the
Remote Desktop session. The default is to allow reconnection “From any client”.
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1.4.

Remote Control Settings – specifies the Remote Control setting to enable or disable, if input
from the controlling session is allowed (i.e. remote control versus just monitoring), and if the
remote user should be notified first. The default is “Enabled (allow input, notify user)”.

Registration/Licensing

1.4.1. Demo version
When initially installed, WinConnect Server VS runs in “demo mode”. While in demo mode, you can evaluate
WinConnect Server VS before you purchase. During the evaluation period, the software enables you to
connect up to 6 Remote Desktop Clients. After the period, the Remote Desktop Clients will be automatically
logoff from the WinConnect Server VS system.
If you do wish to purchase WinConnect Server VS, you will need to access our web site to purchase and
register the software.

1.4.2. Purchase/Internet Registration
Note: You must purchase or register WinConnect Server VS from the computer on which it was installed.
Hence, please ensure that you have installed the WinConnect Server VS software on the computer and make
sure it is working correctly in demo mode and meeting your requirements before purchasing and registering
WinConnect Server VS online.
For Internet Registration, you will need to use Microsoft’s Internet Explorer for this purpose.

Step 1.
On the Windows desktop, right click on the WinConnect Server VS Control Center and then click
“Run as administrator”.

Step 2.
Select Help from the WinConnect Server VS Control Center menu bar and then select “Register on
the Web”.

Step 3.
This will invoke your web browser and link you to the WinConnect Server VS Registration web page.
1. Ensure that you are using the Microsoft’s Internet Explorer as the default browser.
2. Make sure you have logged into the Windows as an Administrator with full access rights.
3. If you are running Windows Vista, Windows 7, Windows® Server 2008 (32-bit & 64-bit),
Windows® Server 2008 R2/R2 Foundation or Windows® Small Business Server 2008/2011 (64-bit),
locate the Internet Explorer (IE) icon in the Windows Quick Launch (next to the Windows Start) or
the IE shortcut via Windows Start/All Programs/Internet Explorer. Right-click on the IE shortcut,
and then click “Run as administrator”. If Windows is in Classic View, click on Windows
Start/Programs/Internet Explorer. Right-click on the IE shortcut, and then click “Run as
administrator”.
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Note: Presume that the Windows User Account Control (UAC) is turned on by default.
4. The "Internet Explorer Enhanced Security Configuration" setting in Windows® Server 2008,
Windows® Server 2008 R2/R2 Foundation or Windows® Small Business Server 2008/2011 must be
turned off.
Click on Windows Start -> Programs -> Administrative Tools -> Server Manager. Under the Security
Information section, click on "Configure IE ESC" in the right panel and then select "Off" for the
Administrator.
5. Within Microsoft Internet Explorer, click on Tools/Internet/Options/Security/Custom Level. Set
the "Reset To:" option to "Medium" and click on the Reset button. Next, click on the "OK" button
to apply the changes. This is the required Internet Explorer setting and is what the WinConnect
Server VS Registration page requires in order to successfully work the purchase/registration process.

Step 4.
Select the language to register.

Step 5.
There are two options in the next registration page. If your WinConnect Server VS software was
purchased from a distributor or came installed on your computer, you will have a serial number that
will need to be entered in the “Serial Number” field on the web page. Once that is done, click on the
“Register & Unlock WinConnect Server VS” button.
If you have obtained WinConnect Server VS on a demo CD or downloaded the WinConnect Server
VS software, there is no serial number to be entered, just click the “Create New License & Purchase
WinConnect Server VS” button.
In either case, the next page will display a form requiring completion; requesting user name and
address information, etc. If you are purchasing the WinConnect Server VS software, credit card
information is also required. Be careful to indicate how many WinConnect Server VS licenses are
desired, as the purchase price will be computed accordingly.
Notes:
When prompted to install and run the "ThinSoft ..." and/or the "SheriffNet Module" ActiveX
controls, you must click on the "Yes" button to install and run the ActiveX controls.
Please wait for each page to load completely before proceeding to the next page.

Step 6.
Once the registration/payment has been approved, your WinConnect Server VS software will be
automatically registered on your computer.

2.

Remote Desktop Client Setup

2.1.

WinConnect Remote Desktop Client Setup

WinConnect is a Remote Desktop Protocol (RDP) 5.1 client software for Linux. With WinConnect, you can
access a WinConnect Server VS Host or a Windows Terminal Server to run Windows applications displayed on
Linux.
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2.1.1. Installing the WinConnect Remote Desktop Client Software for Linux
System
Step 1.
If installing from a WinConnect CD-ROM, insert the CD. If the Setup program does not run
automatically, open a terminal session/window, and run the setup.sh script by entering the
command:
sh /mnt/cdrom/setup.sh
WinConnect Remote Desktop Client software is also available for download at
www.thinsoftinc.com. If installing from a download, place the self- extracting setup file in a
temporary directory and run it by entering the following command (depending on the file you
have downloaded: “standarddemo56” or “standarddemo128”).
sh standarddemo56.sh
or
sh standarddemo128.sh

Step 2.
Follow the instructions on the screen. After reading and accepting the license agreement, click on
the “I Agree…” button and you will be presented with some install options.

Step 3.
At the bottom of the Setup window, you will see a “Begin Install” button. Click the “Begin
Install” button to begin the installation.
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Note: the “Begin Install” button will be disabled if WinConnect is already installed on
your system. To refresh or update an existing copy of WinConnect, you should
uninstall the existing version first.

Step 4.
Congratulations! You have now fully installed the WinConnect Remote Desktop Client software.
Click “View Readme” or “Exit” to quit from the setup program.

2.1.2 Running the WinConnect Remote Desktop Client Software on Linux System
On a Gnome desktop, a menu entry is created under Programs, Applications, WinConnect.
You can also run WinConnect from a terminal session/window by running the command:
winconnect

2.1.3. Connecting to a WinConnect Server VS Host or Windows Terminal Server
When the WinConnect user interface is invoked, the browser results are displayed in the “Available Terminal
Servers” section of the WinConnect screen. All WinConnect Server VS Hosts and Windows Terminal Servers
located on the same subnet as the WinConnect computer should be displayed, listed by both their NetBios
name as well as their IP address.
Highlighting the desired server will un-gray the lower right-hand “Connect” button and clicking this button
will establish the connection to the server. The Resolution drop-down box can be used to set a desired screen
area.
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2.1.4. Customizing a Terminal Connection
The “Stored Profiles” section of the WinConnect screen contains four icon buttons: Connect, New,
Configure and Delete. Once a Connection profile has been created, its name will appear in the Connection
listing window. Clicking the Connect icon will establish the connection using the properties of this connection
profile. If more than one connection profile exists, clicking the drop-down arrow will display all the profiles.
To create a new connection profile, click New.

On the General tab, there are required entry fields for naming the connection profile and the address of the
server desired. There are also optional fields for a User ID and automatic login to the server. It is also possible
to click the box to make a profile the default profile. The profile that is made the default will always be the one
to show in the Connections listing window when WinConnect is first invoked. Also, if WinConnect is run from
a terminal session/window with the –c switch (winconnect –c), a connection will be established to the server
using the default connection profile without invoking the WinConnect user interface. Finally, there is a dropdown menu of different keyboard language options. Clicking Save will preserve any changes.
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On the Display Options tab, there are radio buttons for setting desired screen areas and full screen option.

In full screen mode the Windows desktop will occupy the entire Linux screen. All hotkeys are passed on to
Windows. In this mode, your WinConnect session will most closely resemble an actual Windows computer. In
addition, WinConnect is optimized for full screen mode, so you will see the best performance. When running
in full screen mode, you cannot switch between WinConnect and other Linux applications. This could be an
advantage if you are a network administrator who wish to restrict the user to running WinConnect only.
On the Advanced Options tabs, there are check boxes for disabling mouse motion and drag events, which
help to improve performance.


Disable Window Manager Decorations (borders, etc) - To set the override redirect window property to
turn off the window manager frame. The window will be displayed in the extreme top left of the screen,
rather than being positioned by the window manager. This option is designed to allow a full screen mode.

 Disable Mouse Motion Events - To stop WinConnect from sending mouse motion events to the remote
computer, except when a mouse button is pressed. Disable the option conserves bandwidth, but may
cause some Windows applications to behave in unexpected ways.

 Disable Mouse Drag Events – To stop WinConnect from sending drag events to the remote computer.
Windows applications will see the drag start and end, but they will not see any intermediate mouse
movements. Disable the option conserves bandwidth, but may cause unexpected effects.

 Enable Data Compression – Selecting this option allows data sent between WinConnect and the remote
computer to be compressed. It helps to conserve bandwidth at the cost of some processing time.

 Enable Keepalive Messages – Selecting this option allows WinConnect to terminate if the Terminal
Server fails to respond after a period of time. Default is “Disabled”.


Enable Zoom – The zoom feature is intended for use on devices with small displays such as handheld;
however, it will only work on desktops in a window. Using the resolution options, you can instruct
WinConnect what size the Windows desktop should be. In the zoom mode, the height and width of the
WinConnect window will be one half that size. Use the Zoom key to zoom the display in and out.
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On the Drives tab are entry fields for enabling the local drives in the Linux machine to be able to access from
the Remote Desktop session. Check the “Export path” box and supply the Linux path to the file system
location that you wish to map.
There are also check boxes to map the removable media to the Windows RDP session such as floppy and
CDROM drives. To map a floppy or CD drive, check “Automount” and supply the Linux path to the drive.
The software support up to two of each drives.
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On the Printer tab are entry fields for enabling a printer connected to the Linux machine to be able to print
from the Remote Desktop session. The local printer must first be installed and configured to print normally
from the Linux computer prior to configuring WinConnect for local printing. For printer setup, refer to the
section “Configuring a Printer ”.

On the Serial tab are entry fields for enabling a serial printer or modem connected to the Linux machine to be
able to print or communicate from the Remote Desktop session. Enable the serial port where the device is
attached in the Connection Settings. For more detail on the serial device setup, refer to the sections
“Configuring a Serial Printer” and “Configuring a Serial Port Modem”.

On the Sound/ Keys tab are entry fields for setting desired audio quality and keyboard mapping. The options
are:
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Enable sound – To enable the sound feature.



Use safe sound instead of enhanced sound - On some systems, sound enhancement techniques used by
WinConnect may result in distorted sound. Selecting this option may correct the problem. The default is
not to use this option and leave the box unchecked.

 Send PC scan codes directly - Selecting this option provides the maximum compatibility with Windows
and provides support for the largest number of national keyboards. In some environments this option is
necessary for correct keyboard mapping. This option should be deselected when using WinConnect with
VNC. The default is for this option to be selected.

 Override local windows manager keyboard shortcuts - When WinConnect is running in windowed
mode, hotkeys are used by the local Linux computer. Select this option if you wish to pass on the hotkeys
to Windows when WinConnect is the focus application. The default is not to use this option and leave the
box unchecked. Note that when WinConnect is running in full screen mode, this option is automatically
selected.
The sound feature of WinConnect requires a connection to a Windows Vista, Windows 7, Windows Server
2008 (32-bit & 64-bit), Windows Server 2008 R2/R2 Foundation or Windows Small Business Server
2008/2011 (64-bit). This includes the 'Remote Desktop' capabilities built into a Windows Vista, Windows 7,
Windows Server 2008 (32-bit & 64-bit), Windows Server 2008 R2/R2 Foundation or Windows Small Business
Server 2008/2011 (64-bit).
Sound support also requires installing the "sox" program on the WinConnect computer. The sox program
can be found at:
http://sox.sourceforge.net
It is installed as a standard package by most Linux distributions, for example Red Hat and Mandrake. In this
case you do not need to download and install it.
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2.2.

Configuring a Printer

2.2.1. Setting Up a Printer in Red Hat Linux 7.2
Follow the instructions below to configure your local printer with printconf under Linux. To use printconf, you
must have the root privileges under Linux.

Step 1.
On the GNOME desktop, select Main Menu Button (on the Panel) => Programs => System
=> Printer Configuration to start the graphical version.
You can also run the "printconfig" command from a terminal session/window by typing the
command:
printconf-gui

Step 2.
To add a local printer such as one attached to the parallel port or USB port of your computer,
click the New button in the main printconf window.

Step 3.
You should see a window similar to the one below. Click “Next” to proceed.
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Step 4.
You will then see the screen as shown below. Enter a unique name for the printer in the Queue
Name text field, e.g. lp. This can be any descriptive name for your printer. The printer name
cannot contain spaces and must begin with a letter a through z or A through Z. The valid
characters are a through z, A through Z, 0 through 9, -, and _.
Select Local Printer from the Queue Type menu, and click Next.

Note: For the local printer configuration, there are five types of print queues that can be
configured with printconf:
Local Printer — a printer attached directly to your computer through a parallel or USB port. In
the main printer list, the Queue Type for a local printer is set to LOCAL.
Unix Printer (lpd Spool) — a printer attached to a different UNIX system that can be accessed
over a TCP/IP network (or example, a printer attached to another Red Hat Linux system on
your network). In the main printer list, the Queue Type for a remote UNIX printer is set to LPD.
Windows Printer (SMB) — a printer attached to a different system which is sharing a printer over
a SMB network (for example, a printer attached to a Microsoft Windows machine). In the main
printer list as shown in Figure 8-1, the Queue Type for a remote Windows printer is set to SMB.
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Novell Printer (NCP Queue) — a printer attached to a different system which uses Novell’s
NetWare network technology. In the main printer list, the Queue Type for a remote Novell
printer is set to NCP.
JetDirect Printer — a printer connected directly to the network instead of to a computer. In the
main printer list, the Queue Type for a JetDirect printer is set to JETDIRECT.

Step 5.
Printconf attempts to detect your printer device and display it as shown below. A printer device
attached to the parallel port is usually referred to as /dev/lp0. A printer device attached to the
USB port is usually referred to as /dev/usb/lp0. After selecting your printer device, click Next.

Step 6.
Next, printconf will try to detect what printer is attached to the printer device as shown below.
Select the printer driver from the list. The printers are sorted by manufacturers. Click the arrow
beside the manufacturer for your printer. Find your printer model from the expanded list, and
click the arrow beside the printer name. A list of drivers for your printer will appear. Select the
appropriate printer driver and click on the “Next” button to proceed.
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Step 7.
The last step is to confirm your printer. Click Finish if this is the printer that you want to add.
Click Back to modify your printer configuration.

The new printer will appear in the printer list in the main window. Click the Apply button in the
main window to save your changes and then print a test page to ensure the configuration is
correct.

2.2.2. Setting Up a Printer in Mandrake Linux 8.1
Follow the instructions below to configure your local printer with printtool under Linux. To use printtool, you
must have the root privileges under Linux.

Step 1.
Connect a printer to the computer and power up.

Step 2.
Log in as root.
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Step 3.
Open a terminal session/window and run the command: printtool

Step 4.
You should now see a screen similar to the one below. Choose “Add printer” to start the new
printer wizard.

Step 5.
You will be presented with the list of available connections. Choose “Local Printer” if you are
connecting a printer directly to a parallel / USB port of your computer, in most cases the printer
model will be auto-detected.

Step 6.
You need to provide a name for your printer, to easily identify it if you need to, e.g. lp, and
optionally a Printer description and a physical location. Click “OK”.

39

Step 7.
Next, you will be presented with the list of supported printers. Check whether Printerdrake did
the auto-detection of your printer model correctly. Search for the correct model or a compatible
model in the list if the cursor is pointing to the wrong model. Click “OK” to proceed.

Step 8.
In the next screen, you will be presented with the settings associated with the chosen driver. If
the settings are correct, click “OK”.
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Step 9.
Set the printer as the default printer and print a test page to ensure the configuration is correct.

The above printer setup can also be accomplished under KDE Main Menu Button (on the Panel) => Control
Center => System => Printing Manager.

2.2.3. Setting Up a Printer in WinConnect Server VS Host or Windows Terminal
Server
After connecting to the WinConnect Server VS Host or Windows Terminal Server, you will have a new printer
available to Windows applications. Under Windows Vista, Windows 7, Windows Server 2008 (32-bit & 64-bit),
Windows Server 2008 R2/R2 Foundation or Windows Small Business Server 2008/2011 (64-bit), this printer
will be called something like lp (from WINBOX) where WINBOX is the Linux station name.
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Printing to this printer from the Windows applications will send print data to your local Linux printer.
You may be asked to install printer drivers on the WinConnect Server VS Host or Windows Terminal Server if
your Linux printer model is not already available on the server.
To install the printer drivers on the WinConnect Server VS Host or Windows Terminal Server

Step 1.
Connect to a WinConnect Server VS Host or Windows Terminal Server.

Step 2.
On the Windows desktop, select Main Menu Start Button (on the Panel) => Settings =>
Printers. Right-click on the “lp (from WINBOX)” printer icon where WINBOX is the Linux
station name and select “Properties”.

Step 3.
Under Advanced tab, Windows will try to detect what printer is attached to the printer device as
shown below. Select the appropriate printer driver from the list and click on the “OK” button to
save the settings.

If you are not able to locate the Windows printer drivers from the list, click on the “New
Driver...” button to start the Add Printer Driver Wizard. Click “Next” to proceed.
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Step 4.
Select the manufacturer and model of your printer. Then click on “Next” button.

Step 5.
You have now successfully installing the printer drivers. Click on “Finish” to quit from the Add
Printer Driver Wizard.

Step 6.
Set the printer as the default printer and print a test page to ensure the configuration is correct.
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2.2.4. Setting Up a Printer in WinConnect Remote Desktop Client
Step 1.
On the GNOME desktop, select Main Menu Button (on the Panel) => Programs =>
Applications => WinConnect.
You can also run WinConnect from a terminal session/window by running the command:
winconnect

Step 2.
Once a Connection profile has been created (refer to “Connecting to a WinConnect Server Host
or Windows Terminal Server), click on “Configure” icon.
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Step 3.
All existing Linux print queues can be seen by clicking the drop-down arrow. After selecting the
desired print queue, associate it with a Windows printer driver.
For example, if you had a HP DeskJet 970Cxi printer connected to your Linux system as “lp”,
click on the drop-down arrow of the Windows driver and select the HP DeskJet 970Cxi.
Click “Save” to quit from the connection settings.

If you are not able to locate the Windows printer drivers in the WinConnect user interface, and it
is installed on the Windows Terminal Server, you can enter it manually in the WinConnect user
interface.
As the printer driver must be specified exactly including spaces and capitalization, the easiest way
to do this is to make use of the WinConnect cut-and-paste functionality. Logon to your Windows
server with WinConnect in windowed (not full screen) mode, select Printers and Faxes from the
Start menu. Right click on the appropriate printer driver. Highlight the printer name on the
General tab, right click and select copy.
On the Linux computer, open another copy of the WinConnect Connection Manager. Select the
profile that you wish to edit and select Configure. Place the cursor in the “Windows printer
name” field and press CTRL-V to paste. The correct printer name will be pasted into the printer
configuration.
Alternately, you can add it to the drop down list in WinConnect user interface by editing the file:
/usr/local/share/winconnect/tsprinters
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2.3.

Configuring a Serial Printer

2.3.1. Setting Up a Serial Printer in WinConnect Remote Desktop Client
Step 1.
On the GNOME desktop, select Main Menu Button (on the Panel) => Programs =>
Applications => WinConnect.
You can also run WinConnect from a terminal session/window by running the command:
winconnect

Step 2.
Once a Connection profile has been created (refer to “Connecting to a WinConnect Server Host
or Windows Terminal Server), click on “Configure” icon.

Step 3.
On the Serial tab are entry fields for enabling a serial printer or modem connected to the Linux
machine to be able to print or communicate from the Remote Desktop session. Enable the serial
port where the device is attached e.g. enable Serial Port 0 for COM1, Serial Port 1 for COM2 etc.
Click on the “Save” button to save your connection settings.
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Step 4.
Set the printer as the default printer and print a test page to ensure the configuration is correct.

2.3.2. Setting Up a Serial Printer in WinConnect Server VS Host or Windows
Terminal Server
Step 1.
Connect to a WinConnect Server VS Host or Windows Terminal Server.

Step 2.
On the Windows desktop, select Main Menu Start Button (on the Panel) => Settings => Printers
=> Add Printer to start the Add Printer Wizard.

Step 3.
Select the option “Add a local printer” and click on the “Next” button to proceed.
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Step 4.
All the available ports can be seen by clicking the drop-down arrow.
Select the option “Use an existing port”. Click on the drop-down arrow of the ports listing and
select the port where the printer is connected e.g. TS0033 (from WINBOX: COM1) where
WINBOX is the Linux station name. Click on “Next” button to proceed.

Step 5.
Select the manufacturer and model of your printer. Then click on “Next” button.
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Step 6.
Assign a name to the serial printer and click on the “Next” button.

Step 7.
You have now successfully configuring the serial printer. Click on “Finish” to quit from the Add
Printer Wizard.

2.4.

Configuring a Serial Port Modem

2.4.1. Setting Up a Serial Port Modem in WinConnect Remote Desktop Client
Step 1.
On the GNOME desktop, select Main Menu Button (on the Panel) => Programs =>
Applications => WinConnect.
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You can also run WinConnect from a terminal session/window by running the command:
winconnect

Step 2.
Once a Connection profile has been created (refer to “Connecting to a WinConnect Server Host
or Windows Terminal Server), click on “Configure” icon.

Step 3.
On the Serial tab are entry fields for enabling a serial printer or modem connected to the Linux
machine to be able to print or communicate from the Remote Desktop session. Enable the serial
port where the device is attached e.g. enable Serial Port 0 for COM1, Serial Port 1 for COM2 etc.
Click on the “Save” button to save your connection settings.

2.4.2. Setting Up a Serial Port Modem in WinConnect Server VS Host or Windows
Terminal Server
Follow the instructions below to set up a serial port modem in the WinConnect Server VS Host or Windows
Terminal Server. The Remote Desktop Client can only be connected to the other computers via Phone &
Modem Options. Dial up Networking is currently not supported.
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Step 1.
Connect to a WinConnect Server VS Host or Windows Terminal Server.

Step 2.
On the Windows desktop, select Main Menu Start Button (on the Panel) => Settings =>
Control Panel => Classic View => Phone and Modem Options. Create a new connection and
click on “OK” button.

Step 3.
The last step is to configure the connection settings and click on “OK” button.
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2.5.

Connecting to a Remote Windows Server Using a Dial-up Modem

To set-up a Dial-up connection, ensure that the serial ports and modem have been installed; and supporting
Point to Point Protocol (PPP). One way to check for serial-port recognition is to use the dmesg command
under Linux which displays the boot message. Run the dmesg command (piped through the less command) and
look for lines in the output describing serial ports similar to the following:
# dmesg | less
.......
ttyS00 at 0x03f8 (irq=4) is a 16550A
ttyS01 at 0x02fb (irq=5) is a 16550A
ttyS03 at 0x02e8(irq=3) is a 16550A
.........
To check if PPP exist on the system, use the dmesg command again.
# dmesg | less
........
PPP: version 2.3.7
PPP line discipline registered
Another quick way to check if PPP is installed is to use the rpm command.
# rpm -q ppp
ppp-2.3.11-7

2.5.1. Setting Up a Dialer from GNOME Desktop Panel
Step 1.
On the GNOME desktop, select Main Menu Button (on the Panel) => Programs => Internet
=> Dialup Configuration to create a new Internet connection. Click on the “Next” button to
proceed.

Step 2.
If the symbolic link /dev/modem/ does not exist, click on “Add” and then “Next” to query the
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modem. If a modem is found, click on the “Keep this modem” and “Next” buttons to select
device as “/dev/ttyS0”.

Step 3.
Enter a name for the dialup account, along with the ISP’s dialup number. Then click on the
“Next” button.

Step 4.
Enter your assigned username and password. Click on “Next” button to proceed.
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Step 5.
In the next screen, you will be asked to select your ISP. If your ISP is not listed, just select
Normal ISP and click on “Next” button.

Step 6.
Click on “Finish” to save the account.

Step 7.
To start your PPP connection, select Main Menu Button (on the Panel) => Programs =>
Internet => RH PPP Dialer.

Step 8.
Select the ISP account that you have created and click on “OK” to start the connection.
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Note: In order to connect to Internet successfully, you may need to specify your ISP’s DNS
servers in your system’s /etc/resolv.conf file.
e.g enter the line using this format:
nameserver 165.21.83.88
nameserver 165.21.100.88

2.5.2. Setting Up a Dialer from KDE Desktop Panel
Step 1.
On the KDE desktop, select Main Menu Button (on the Panel) => Internet => Internet Dialer.
You should see the KPPP configuration dialog box similar to the one. Click on “Setup” button.

Step 2.
Under the Account tab, click on the “New” button.

Step 3.
Click on “Dialog Setup” to create the new account.
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Step 4.
Follow the instructions on the screen. Click “Next” to proceed.

Step 5.
Enter the name of your ISP along with the ISP’s phone number.
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Step 6.
Click on the IP tab and select whether it is a dynamic or static IP address assigned to your
computer.

Step 7.
Click on the DNS tab to enter your ISP’s DNS IP address.
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Step 8.
Under the Device tab, select the correct modem device and connection speed for your modem.

Step 9.
Under the Modem tab, you can change the default modem AT commands, query your modem,
or test your modem by using KPPP’s built-in terminal program. You can also change the
modem’s volume by using the slider control in the dialog box.
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Step 10.
Under the Misc. Tab, you can select or deselect the options according to your preference. If you
click “Dock into Panel” on connect, KPPP will display satiny modem icon with blinking send
and receive lights.

Step 11.
After you have configured the Internet dialer settings, click “OK” and the KPPP windows will
appear as shown below. To start your Internet connection, click on the “Connect” button.

2.6.

Automating a Terminal Connection

You can run WinConnect from your Linux startup scripts. If the terminal is to be used by multiple users, you
can customize each user’s connection individually.
The script that automatically runs on login can be found in:
/home/user name/.bashrc
As each user runs a different script, these scripts can be customized on a per-user basis.
If WinConnect is placed in the .bashrc script with no parameters, it will run automatically and display the
standard user interface. There are several command line parameters supported by WinConnect that can be used
to customize the connection on a per-user basis. These are:
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-c : If there is a default connection profile defined, WinConnect will automatically connect to the server
using that profile. If there is no default profile, WinConnect will seek out a WinConnect Server VS Host or
Windows Terminal Server on the network. If one is found, it will automatically connect to it.
Example: winconnect –c
Connection name: If you specify a connection profile name, WinConnect will automatically connect using
that profile.
Example: winconnect accounting
Using the connection name parameter, you can edit each user’s .bashrc file to automatically connect them to a
WinConnect Server VS Host or Windows Terminal Server using a different connection profile.
Upon termination of the Remote Desktop session, the user will return to the Linux desktop. If you wish the
user to return to the Linux login, you should add the command “logout” to the .bashrc file following the
winconnect command.
As an example, if you wanted user Rosa to automatically connect to the accounting server on logging in, you
would edit the file
/home/Rosa/.bashrc
You would add the lines
Winconnect “accounting-profile”
logout
to the end of the file. You would then use the WinConnect user interface to create a connection profile named
“accounting-profile” (without the quotes).
If your profile name consists entirely of alpha-numeric characters (no hyphens, for example) the quotes aren’t
required.

2.7.

Uninstalling WinConnect Remote Desktop Client Software

Part of the install process is to create a script that will uninstall WinConnect. This script is called "uninstall" and
is in the WinConnect directory. The command to uninstall WinConnect is:
sh /usr/local/share/winconnect/uninstall
Run this script and all WinConnect files, links, and directories will be removed.

2.8.

OpenLinux problem

Under Caldera OpenLinux 2.4, the link to the terminal server browser program is hidden by a link that
OpenLinux creates to load Netscape. To workaround this issue, remove the OpenLinux link before installing
WinConnect:
rm /usr/bin/browser
On the OpenLinux 2.4 KDE desktop, a menu entry for WinConnect is not created. You can still run
WinConnect from a terminal by running the command:
winconnect
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2.9.

Browser problem

The WinConnect “browser” program tries to discover the WinConnect Server VS Hosts or Windows
Terminal Servers on your subnet. Discovered servers are displayed in the WinConnect user interface.
If the technique used by the browser does not work on your network, or if you wish to have terminal servers
outside your subnet appear in the WinConnect “Available Terminal Servers” list, you can manually add
servers to the list by editing the file:
/usr/local/share/winconnect/tshosts

2.10. Registration/ Licensing
To register the software, select “License” from the WinConnect menu and then select “Individual License” to
license a single copy of WinConnect or “ Site License” to license multiple copies of WinConnect.

2.10.1. WinConnect Individual License Activation
Note: Please make sure that WinConnect is running correctly under demo mode before licensing WinConnect.

Step 1.
In the Internet browser, connect to the web site at:
http://www.thinsoftinc.com

Step 2.
Go to the Purchase, WinConnect Single License web page.

Step 3.
Enter the Ethernet (MAC) address you see below into the form on that web page.

Step 4.
Continue through the purchasing process.
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Step 5.
After a successful purchase, you will receive an unlock code.

Step 6.
Enter the unlock code in the entry box as shown below.

Step 7.
Congratulations! You now have a licensed copy of WinConnect software.

2.11. Updating WinConnect
If you wish to update your WinConnect software to the most recent version, you can do so by downloading it
from our web site.
1.

Log in as root.

2.

Download the new version of WinConnect from http://www.thinsoftinc.com.

3.

Before installing, note the unlock code from the WinConnect "Menu>License>Show information"
dialog box.
Note: If you are upgrading from versions prior to 1.3, please email support@thinsoftinc.com for
assistance.

4.

Uninstall the installed version of WinConnect. From a terminal session run
sh /usr/local/share/winconnect/uninstall.

5.

Install the new version of WinConnect following the standard installation instructions.
Restart the computer after successfully installing the WinConnect software.

6.

Use the unlock code saved in step 3 to unlock the new version.

You have now successfully updated your WinConnect software to the most recent version.
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3.

Microsoft Windows Remote Desktop Client
Setup

3.1.

Installing the Remote Desktop Client Software for Windows System

The Remote Desktop Client software allows Windows platforms to remotely connect to a WinConnect Server
VS Host to run Windows applications.
a.

The Remote Desktop Client software for Microsoft Windows 95, Windows 98, Windows Me, Windows
NT, Windows 2000, Windows XP, Windows Small Business Server 2003 and Windows CE is available for
download at the Microsoft web site,
http://www.microsoft.com/downloads/details.aspx?FamilyID=80111f21-d48d-426e-96c208aa2bd23a49&DisplayLang=en.

b.

The Remote Desktop Client software for Microsoft Windows Vista, Windows 7, Windows Server 2008
(32-bit & 64-bit), Windows Server 2008 R2/R2 Foundation or Windows Small Business Server 2008/2011
(64-bit) is available for download at the Microsoft web site,
http://www.microsoft.com/downloads/details.aspx?FamilyID=26f11f0c-0d18-4306-abcfd4f18c8f5df9&DisplayLang=en.
This version of Remote Desktop Terminal Services Client software provides a way to use any new
Terminal Services features introduced in Microsoft Windows Vista, Windows 7, Windows Server 2008,
Windows Server 2008 R2/R2 Foundation and Windows Small Business Server 2008/2011 from a
computer running Microsoft Windows XP with Service Pack 2.

The client software is installed by default on computers running Windows Vista, Windows 7, Windows Server
2008 (32-bit & 64-bit), Windows Server 2008 R2/R2 Foundation or Windows Small Business Server
2008/2011 (64-bit).
To install Remote Desktop Client software on a client computer:

Step 1.
Locate the Remote Desktop Client software where you have download and saved onto your hard
disk. Double-click on the filename and you should see the screen similar to the one below.
Click on the “Next” button to proceed.
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Step 2.
Follow the instructions on the screen. After reading and accepting the license agreement, click on
the “I Accept…” button.

Step 3.
Provide the Customer Information as requested.

Step 4.
Click on the “Install” button to begin the installation.
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Step 5.
Congratulations! You have now fully installed the Remote Desktop Client software.
Click “Finish” to quit from the InstallShield Wizard.

If you need any technical assistance or more information on the Microsoft Remote Desktop Client Software,
please refer to Microsoft web site at http://www.microsoft.com.

3.2.

Start a Remote Desktop Session

Once you have setup the WinConnect Server VS Host computer to allow remote connections, and installed
client software on a Windows-based client computer, you are ready to start a Remote Desktop session. You
must first establish a virtual private network connection, Internet connection or remote access service
connection from your client computer to your office network, or Host computer.

3.2.1. To make a virtual private network (VPN) connection

Step 1.
Open Network Connections. (Click Start => Control Panel => Network and Sharing Center.
Under Tasks, click Set up a connection or network)
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Step 2.
Click Connect to a workplace, and then click Next as shown below.

Step 4.
Click Use my Internet connection (VPN), click Next, and then follow the instructions in the
wizard.
Notes: You can create multiple Virtual Private Network (VPN) connections by copying them in
the Network Connections folder. You can then rename the connections and modify connection
settings. By doing so, you can easily create different connections to accommodate multiple hosts,
security options, and so on.
If you have an active Winsock Proxy client, you cannot create a VPN. A Winsock Proxy client
immediately redirects data to a configured proxy server before the data can be processed in the
fashion required by a VPN. To establish a VPN, you should disable the Winsock Proxy client.

3.2.2. To create a new Remote Desktop Connection
Step 1.
Open Remote Desktop Connection. (Click Start, point to Programs or All Programs, point to
Accessories, and then click Remote Desktop Connection.)

Step 2.
Click on the Options button to configure the Windows logon and connection settings.
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Step 3.
In Computer, type the computer name or IP address of the WinConnect Server VS Host. Click
Connect.

Step 4.
Type your user name and password, and then click ok to save the settings and make connection
to the WinConnect Server VS system.

The Log On to Windows dialog box appears.
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Step 5.
In the Log On to Windows dialog box, type your user name and password (if required), and then
press the Enter key. The Remote Desktop window will open and you will see the desktop
settings, files, and programs that are on your office computer. Your office computer will remain
locked. Nobody will be able to work at your office computer without a password, nor will anyone
see the work you are doing on your office computer remotely.
Note: To change your connection settings, (such as screen size, automatic logon information,
and performance options), click Options before you connect.

3.2.3. To open a saved connection
Step 1.
In Windows Explorer, open the Documents folder.

Step 2.
Click the .Rdp file for the connection you want to open.
Note: A Remote Desktop file (.rdp) file contains all of the information for a connection to a
remote computer, including the Options settings that were configured when the file was saved.
You can customize any number of .rdp files, including files for connecting to the same computer
with different settings. For example, you can save a file that connects to MyComputer in full
screen mode and another file that connects to the same computer in 800×600 screen size. By
default, .rdp files are saved in the Documents folder. To edit an .rdp file and change the
connections settings it contains, right–click the file and then click Edit.

3.2.4. To log off and end the Remote Desktop session
Step 1.
In the Remote Desktop Connection window, click Start.

Step 2.
Select Log Off <username>, and then click OK.

3.2.5. To disconnect the Remote Desktop session
Step 1.
In the Remote Desktop Connection window, click Start.

Step 2.
Select Disconnect <username>, and then click OK.
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3.3.

Local Printer Re-direction

I. For local printer re-direction on the remote client (i.e. printing to the local printer connected physically to the
remote client), follow the instructions below:
1. On the remote client, before connecting to the WinConnect Server VS system, you will need to install the
printer as per normal and make sure that the printer is working correctly, please refer to the printer user manual
for installation instructions.
2. On the remote client, open the MS Remote Desktop Connection software, click on Options --> Local
Resources, and check "Printers". Then connect to WinConnect Server VS system.
On the remote desktop session, click on Start --> Settings --> Printers, you should then see your printer.
NOTES:
Printing at the remote client location is a function of the MS Remote Desktop Connection software being used.
The MS Remote Desktop Connection software send the information about the local printer to WinConnect
Server VS/Windows Vista/Windows 7/Windows Small Business Server 2008/Windows Small Business Server
2011/Windows Server 2008/Windows Server 2008 R2/Windows Server 2008 R2 Foundation system and if
that printer is listed among the Windows native printer list, then all will go fine. If the printer model is not one
contained within the list of Windows native printers, then it will be necessary to install the printer driver on the
WinConnect Server VS/ Windows Vista/Windows 7/Windows Small Business Server 2008/Windows Small
Business Server 2011/Windows Server 2008/Windows Server 2008 R2/Windows Server 2008 R2 Foundation
system first. In some cases, to install the printer correctly on the WinConnect Server VS/ Windows
Vista/Windows Small Business Server 2008/Windows Small Business Server 2011/Windows Server
2008/Windows Server 2008 R2/Windows Server 2008 R2 Foundation system will require actually connecting
the printer to the WinConnect Server VS/ Windows Vista/Windows 7/Windows Small Business Server
2008/Windows Small Business Server 2011/Windows Server 2008/Windows Server 2008 R2/Windows Server
2008 R2 Foundation system or the printer driver will not install properly. When this installation is done, the
printer should be detected as a local printer when the remote client is connected to the WinConnect Server
VS/ Windows Vista/Windows 7/Windows Small Business Server 2008/Windows Small Business Server
2011/Windows Server 2008/Windows Server 2008 R2/Windows Server 2008 R2 Foundation.
If local printing still does not work after following the above procedure, you will need to check with the printer
manufacturer to verify if the printer driver is designed to support Windows Terminal Services, or the procedure
to install the printer and it's printer driver to work under Windows Terminal Services
Printers that use ports that do not begin with COM, LPT, or USB are not redirected in a remote desktop
connection. Please check with your printer manufacturer's Technical Support on how to configure your printer
to use a COM/LPT/USB port.
II. For local printer redirection for local printer using DOT port or network printer, refer to the following MS
article (Note: the local printer driver must be installed on the Host):
http://support.microsoft.com/kb/302361
Printers That Use Ports That Do Not Begin With COM, LPT, or USB Are Not Redirected in a Remote
Desktop or Terminal Services Session
View products that this article applies to.
Article ID : 302361
Last Review : December 3, 2007
Revision : 4.8
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This article was previously published under Q302361
SYMPTOMS
When you use Remote Desktop Connection or the Terminal Services Client version 4.0 or 5.0 to connect to
another Windows-based computer from a computer that is not running Windows Server 2003, your local
printers may not be redirected. As a result, your local printers are not available in the remote desktop or
terminal services session.
For example, if your Windows XP-based computer has a multifunction print device using a DOT4 port, it may
not be redirected in a remote desktop session to a Windows 2000- or Windows Server 2003-based computer.
CAUSE
This problem occurs because the printer port does not begin with COM, LPT, or USB. By default, printer port
names that do not begin with COM, LPT, or USB are only redirected in Windows Server 2003. By default,
multifunction print devices may not be redirected unless you are running Windows Server 2003 on your local
computer because they use DOT4 ports.
RESOLUTION
To resolve this problem on a computer that is not running Windows Server 2003, force all ports (including
DOT4) on the client computer to be filtered for redirection. To do this, add a DWORD value named
FilterQueueType to HKEY_CURRENT_USER\Software\Microsoft\Terminal Server
Client\Default\AddIns\RDPDR and set its value data to FFFFFFFF.
Follow these steps, and then quit Registry Editor:
1. Click Start, click Run, type regedit, and then click OK.
2. Locate and then click the following key in the registry:
HKEY_CURRENT_USER\Software\Microsoft\Terminal Server Client\Default\AddIns\RDPDR
3. On the Edit menu, point to New, and then click DWORD Value.
4. Type FilterQueueType, and then press ENTER.
5. On the Edit menu, click Modify.
6. Type FFFFFFFF, and then click OK.
This enables all ports on the client to be redirected.
To work around this problem on a client computer that has a multifunction print device, change the port that
the multifunction print device uses from DOT4 to an LPT port.
For example, to configure a multifunction print device to use an LPT port on a Windows XP-based computer,
follow these steps:
1. In Control Panel, open Printers and Faxes.
2. Right-click the local printer that is not redirected, and then click Properties.
3. Click the Ports tab, click an LPT port, and then click Apply.
The printer should now appear next to that port.
4. Close the Printer Properties window, and then reconnect by using Remote Desktop.
Important When a multifunction printer is using a standard LPT port instead of the DOT4 port, it loses its
multifunction capabilities, such as scanning, faxing, or copying. To regain the multifunction capabilities, the
print device must use the DOT4 port.
STATUS
This behavior is by design.
MORE INFORMATION
To view the port name for your printer, or to determine if the device uses a DOT4 port, view the properties of
that printer, and then click the Ports(or the Details) tab.
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3.4. Connecting to Console Session of Windows Vista, Windows 7 or Windows
Server 2008 (32-bit)
Background:
1. Without WinConnect Server VS software installed, Windows Server 2008 (32-bit) native terminal services or
Windows Vista/Windows 7 (32-bit) native remote desktop listens to port 3389 (0d3d Hex).
2. With WinConnect Server VS software installed, WinConnect Server VS software listens to port 3389 (0d3d
Hex) and Windows Server 2008 (32-bit) native terminal services or Windows Vista/Windows 7 (32-bit) native
remote desktop listens to port 36157 (8d3d Hex).
Note: The difference between ports 0d3d Hex and 8d3d Hex is:
a. the most significant bit of 8d3d Hex is set and the most significant bit of 0d3d Hex is cleared; or
b. 8d3d Hex is the equivalent of (0d3d Hex OR 8000 Hex); or
c. 0d3d Hex is the equivalent of (8d3d Hex AND 0FFF Hex).
Follow the steps described below to connect to the WinConnect Server VS system's Console session from the
remote client via the Remote Desktop Connection software:

Step 1.
Open Remote Desktop Connection (Click Start, point to Programs or All Programs, point to Accessories, and then click
Remote Desktop Connection).

Step 2.
Click on the Options button to configure the Windows Logon and connection settings.

Step 3.
In Computer, type in the IP address of WinConnect Server VS sytem and port number used by WinConnect
Server VS software (e.g. 218.10.0.30:36157; port number must be in decimal). Click Connect.

Step 4.
In the Log On to Windows dialog box, type in the same user name and password that user has logged on the
WinConnect Server VS system, and then press the Enter key. The Remote Desktop window will open.
Note: If you are still not able to establish the connection, please check to make sure that the TCP port 36157 is
not blocked by any firewall on the WinConnect Server VS system, remote client(s) and/or network.
Additionally, if you are using a router, please ensure the router is configured to forward port 36157 to the
WinConnect Server VS Host.
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3.5. Connecting to Console Session of Windows Vista, Windows 7, Windows
Small Business Server 2008/2011, Windows Server 2008, Windows Server 2008 R2
or Windows Server 2008 R2 Foundation (64-bit)
Follow the steps described below to connect to the WinConnect Server VS system's Console session from the
remote client via the Remote Desktop Connection software:

Step 1.
Open Remote Desktop Connection (Click Start, point to Programs or All Programs, point to Accessories, and then click
Remote Desktop Connection).

Step 2.
Click on the Options button to configure the Windows Logon and connection settings.

Step 3.
In Computer, type in the IP address of WinConnect Server VS system used by WinConnect Server VS
software (e.g. 218.10.0.30 /admin). Click Connect.

Step 4.
In the Log On to Windows dialog box, type in the same user name and password that user has logged on the
WinConnect Server VS system, and then press the Enter key. The Remote Desktop window will open.
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4.

Configuring Router's Port Forwarding For
Remote Desktop Access

The Remote Desktop Client software allows Windows platforms to remotely connect to a WinConnect Server
VS Host to run Windows applications.
First, get the IP address of the host computer (the computer that will have WinConnect Server VS installed on
it).
Click Start then Run and enter the letters CMD.
In the DOS box that appears, enter the command: ipconfig. Then hit the Enter key.
The computer’s IP address will be displayed in the information shown. Make note of it.
Next, open a browser and enter the URL http://www.portforward.com in the address bar.
At the bottom of PortForward’s opening page, make a note of the IP address shown after the text: Your
external IP address is
This IP address is what your remote users will need to enter into the “Computer” field in the Microsoft
Remote Desktop Connection program on their computers. Remote Desktop Connection is part of Windows
Vista, Windows 7, Windows Server 2008 (32-bit & 64-bit), Windows Server 2008 R2/R2 Foundation and
Windows Small Business Server 2008/2011 (64-bit) and can be found on the Accessories menu
(Start/Programs/Accessories).
In the second paragraph on the PortForward opening page, locate the word Routers and click on it. This will
take you to a page displaying most brands and models of routers. Locate the specific brand and model of router
used in your location and click on it (if your router is not listed, please contact your router's vendor for details
on how to configure your router's port forwarding for Remote Desktop access).
This action takes you to the Application page. Scroll down until you locate Remote Desktop and click on it.
You will now see a step-by-step set of instructions for configuring your router to allow Remote Desktop
access. You will be asked to enter an IP address at the beginning of the configuration routine; this is the IP
address you obtained in the first part of these instructions.
Note:
Static IP address:
There are two IP addresses involved regarding Remote Desktop access. One is the external IP address owned
by the router and the other is the internal IP address of the host computer. Ideally, both of these should be
“static” (meaning they never change). Unfortunately, this is not always the case.
The external IP address is controlled by your Internet provider. You may check with them if you are not sure
whether your account has a static IP address.
The host computer’s IP address is entirely in your control. For detailed information on how to set your host
computer to employ a static IP address, please see this web page,
http://www.portforward.com/networking/static-xp.htm
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Technical Support
Technical support offered by ThinSoft Pte Ltd
WinConnect products must be registered with ThinSoft before technical support may be offered.
Registration may be completed by registering online at our World Wide Web site. Free support via fax and
email is offered for sixty (60) days from the date of registration. Our technical staff is available to answer
questions, troubleshoot problems and to assist in the installation of WinConnect products. Before
requesting technical support, please be prepared to provide information including the date and
place of purchase and product serial number (______________________).
http://www.thinsoftinc.com
ThinSoft Pte Ltd
23 Tai Seng Drive
#06-00
Singapore 535224
Fax: (65)-6289-7308
email: support@thinsoftinc.com
Support hours are 9:00 to 5:00 local time.
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